
  

Introduction

Smart1DCutting is an easy to use and efficient tool for length cutting optimization. All you have to do is 
input sources and parts and start optimization. 
 
At the end of the optimization process, Smart1DCutting shows the layouts and needed sources in a 
cutting layout. Cutting layouts can be saved and reused later without the need to run optimization again. 
Sources and remaining materials (reusable offcuts) are stored in a stock management system.
Smart1DCutting allows you to print labels that include parts, sources and reusable offcuts information as 
well as the cutting layout, cutting report, and sources stock.
 
Different materials are recognized and managed by Smart1DCutting, allowing the input of mixed material 
parts and sources.

Smart1DCutting supports multiuser connections. By setting the database location to the same network 
drive on all workstations, you can have your data stored and accessed in one central location.
 
If you have improvement suggestions, please email us: support@rasterweq.com. We are pleased about 
any form of feedback.
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New in this release (v. 1.3 - 2011-05-16)

l new feature: added option to set the location of language files 
l new feature: added option to export labels to CSV file 
l new feature: added "Start label" option to allow the printing of labels on a partial sheet (i.e.: labels 

can be printed starting with label no. 11). This is useful when you used 10 labels on a previous job 
and would like to use the remaining labels on the current labels sheet. 

l new feature: added option to set the price per source to allow different prices for sources of the 
same material but having different lengths. 

l new feature: added cutting price per panel option 
l bug fixed: for sources with trims defined the trims were not accounted correctly in the cost 

calculation grid. We fixed this issue by displaying the full panel size in the cost calculation grid and by 
adding the trims surface to the "Waste" column as "scrap". 

 

version 1.2 - 2010-07-24

l new feature: added filter function to the cutting layout section 
l new feature: added new optimization level: "Level 3", for better optimized cutting plans 
l new feature: added option to set material price per source 
l new feature: added "Compact mode" option to display/print a compact version of the cutting plan 
l new feature: added "Creation date" information for jobs and "Last update" information for cutting 

layouts 
l new feature: added option to choose the location where the cutting layout is stored: on network 

database or on the local computer (under "Database" tab of the "Settings" window) 
l new feature: added "Auto-Save" functionality for jobs (under "Database" tab of the "Settings" 

window) 
l new feature: added functionality to remember the printer used for labels and for the other areas of 

the software. For ex.: if a roll printer is used for labels and a standard A4/Letter size printer for the 
cutting layout, Smart1DCutting will automatically select the correct printer for the task. 

l new feature: added "Column widths" button to the print preview window that allow the user to 
configure the column widths for the printed reports 

l bug fixed: the optimization engine grouped layouts with parts of same sizes but different part number, 
description or partcode. This resulted in a smaller number of cutting layout pages but some of the 
parts were not visible on the cutting layout (although they were optimized) 

l bug fixed: when pasting fractional data from an .xls file it happened that the fractional data was 
incorrectly displayed as a date value 

l bug fixed: the optimization engine (Level 2) was improved to correct some existing performance issues 
l bug fixed: various other minor bugs fixed 

 

version 1.1 - 2009-05-25

l new feature: the cutting layout can be saved as XML file 
l new feature: added filter function for the jobs grid 
l new feature: other various minor new features and improvements 
l bug fixed: when in single job mode, the panels and parts grids were not reloaded if the language was 

changed! 
l bug fixed: "Works Cost" and "Cutting Cost" grids were sometimes displayed incorrectly in the Cost 

Calculation preview window 
l bug fixed: the page orientation function from the label styles grid did not changed the printer page 

orientation 
l bug fixed: various minor bugs were fixed 
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Key features

l Measurements in Metric (mm, cm, dm, m) and US Customary / British Imperial (in, ft, din) units 
l Input sources and parts data manually through the keyboard, by loading native Smart1DCutting files 

or by importing from CSV files or from the clipboard. 
l Jobs management system 
l Highly optimized cutting layouts (avg. 95%-97% coverage) computed very fast. Even for 2000 parts 

the cutting layout is generated in less than 10 seconds on today's modest computers. 
l Multiuser support 
l Cutting angles information for parts 
l Preview/Print all layouts and reports 
l The cutting layout can be saved for later reuse 
l The cutting layout can be saved to a TXT or XML file for further processing 
l Adjustable cutting blade thickness per material type 
l Margin width control for sources and parts 
l Adjustable optimization level 
l Handle different material types for sources and parts 
l Detailed report, showing a list of used sources, resulted parts and offcuts, with their dimensions and 

layout statistics 
l Cost calculation report 
l Printable part, source and offcut labels 
l Print barcodes on parts labels 
l Stock management system 
l Multilanguage support 
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System Requirements

Your computer must have the following minimum requirements to run Smart1DCutting:

l Pentium - 350 MHz processor or better  
l 64 MB of available memory 
l 10 MB of free hard disk space 
l Graphic system capable of displaying 1024x768 pixels in 256 colors 
l Microsoft Windows 95/98/NT 4.0/ME/2000/XP/Vista
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Getting Started

This section describes the basics of using Smart1DCutting.
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Get First Results In Five Simple Steps

To see Smart1DCutting in action let's start with a simple example. Suppose you have the following 
source: 

Material Length Quantity
PVC Pipe 2500 mm  20

 

And you want to cut the following pieces out of it: 

 

Material Length Quantity
PVC Pipe 450 mm  1
PVC Pipe 534 mm  2
PVC Pipe 576 mm  16
PVC Pipe 518 mm  1
PVC Pipe 456 mm  8
PVC Pipe 456 mm  1

 

You need to perform 5 simple steps to get the results: 

 

1. Create a new job 
2. Enter sources - dimensions and quantities  
3. Enter parts - dimensions and quantities  
4. Run optimization 
5. Preview/Print the results 

Let's see how these steps would be actually performed with Smart1DCutting: 
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1. Select the "Sources and Parts" tab in the main screen. Look for Jobs area:  

 

Create a new job by clicking the  button from the buttons bar. Enter a job name and optionally a 
description for the job.

2. Look for Sources area: 

Enter dimensions and quantities for each source. To set the sources quantity to unlimited, just 
type 'u' or "unlimited" in the "Qty" field.
You can leave the material field empty for now. Or choose the same material for all sources and 
parts.
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3. Look for Parts area.

Enter dimensions and quantities for each part

4. Run optimization by clicking on the "Optimize"  button or by pressing the F7 key. 
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5. After optimization you will see the cutting layout. Use the button bar to move through the 
pages. You can print the layout by pressing the "Print"  button and you can also save the 

cutting layout by clicking on the "Save"  button. 

 

That's it! These steps show the fundamentals of using Smart1DCutting. To find information that is more 
detailed, please read the rest of this manual.
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Setting Program Options

Use this section to learn how to configure program options.

 

Select Options -> Settings from the main menu to bring up the settings dialog or click the "Settings" 
button  from the buttons bar.

To save changes click the "Save"  button. To cancel changes click the "Exit"  button.
 
Click on the links bellow to see more information about settings 

l Optimization 
l Sources and Parts 
l Units Options 
l Print and Display Options 
l Database Options 
l Language Options 

Page 10 of 76



  

Optimization

In the "Optimization" section you can configure optimization related settings.
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Options 
l Repeat layout when usage is at least XX % - when checked, the optimization engine will try to 

repeat a cutting layout if the usage on that layout is at least the value specified. Please note that 
checking this box will not guarantee that the layout will be repeated. There must be enough parts and 
sources left for at least another identical layout. Values lower than 90% are not recommended.

l Give priority to offcuts when usage on offcuts is at least XX % - when checked, the optimization 
engine will give priority to offcuts when choosing the best coverage. For ex. if this option is set to 50% 
and the usage is 50% on an offcut and 80% on a new source, the offcut will be selected for that layout 
even f the coverage on it is smaller than on the new source. This way you can force the program to 
optimize offcuts before "touching" the new sources.

l Optimize only sources available in stock - when checked, the optimization engine wil check the 
stock for the availability of each source. Sources not found in stock will be disabled and marked with 
red color, while sources found in stock but with insufficient qty will be marked with blue color and their 
qty will be reduced to the available qty in stock. Use this option if you want to make sure you have in 
stock all the needed materials before starting to cut something.

l Group layouts with parts of equal sizes but different part numbers - when checked, the 
optimization engine will try to group parts of identical length (but different part number) on the same 
layout page, in order to reduce the page count of the cutting layout. Although the source usage is the 
same, this option may be of help when the only difference between parts with identical sizes is their 
part number (i.e. description and part code is not used). 
Please note that if your job contains parts with equal sizes but different description or partcode and 
you check this option, the cutting layout will display the description and partcode of only one of the 
grouped parts.

Saw width 
l Unique / Global value - use this option to set the same saw width for all material types.  
l Per material value - use this option to set different saw widths for each material type. This can be 

usefull if you would like to generate cutting layouts for many different materials (.i.e. PVC Pipes and 
Steel Pipes). To configure the saw width for each material click the "Settings" button to open the 
Materials window. 
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Sources and Parts

In the "Sources and Parts" section you can set default values for sources and parts. Default values are 
used only when manually adding a new source or part or when adding sources from stock. For imported or 
loaded data, default values do not apply.

Sources - Default values 
Parts - Default values  

Sources - Default values 
l Trims - sometimes, if source margins are damaged, it may be useful to get a cutting layout for a length 

smaller than the source itself. 
Setting trim values for sources will cause the optimization engine to consider the source Length = 
Length - Left trim - Rigth trim. 
Every new source added manually or from stock will have its trim values set to the default trim values. 

l Material - specifies the default material type for new sources. Every new source added manually will 
have its material set to the default material. Sources added from stock will retain their stock material.

The sources default values can be applied to the sources in the current job as well. To apply the sources 
default values to all sources in the current job click the "Apply default values..." button from the sources 
section and check the default values you would like to apply, as illustrated in the picture below:

Then click "OK". The selected default values will be applied to all sources in the current job.
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Parts - Default values 
l Margins - setting margin values for parts will cause the optimization engine to consider the part Length 

= Length + Left margin + Right margin.
Every new part added manually will have its margin values set to the default margin values. 

l Left angle & Right angle - specifies the default cutting angle for each side of the part. Every new part 
added manually will have its cutting angle info set to the default cutting angle values.

l Works - specifies the default value of works for parts. Every new part added manually will have its 
works value set to the default works value. 

The parts default values can be applied to the parts in the current job as well. To apply the parts default 
values to all parts in the current job click the "Apply default values..." button from the parts section and 
check the default values you would like to apply, as illustrated in the picture below:

Then click "OK". The selected default values will be applied to all parts in the current job.
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l Display Units - specifies the units in which sources and parts dimensions are displayed.  

l Convert to the lowest common denominator - if this is checked when using fractional inches, the 
software will convert to the lowest common denominator. 
For ex. 4/16" will be displayed as 1/4".

l Display Precision - displays precision for imperial units (feets and inches). For ex. 1500 mm converted 
in inches can be:
59" 4/64 for a precision of 1/64
59" 2/32 for a precision of 1/32
59" 1/16 for a precision of 1/16
59" 1/10 for a precision of 1/10
59" for a precision of 1/8

A value of 1/64 means more accuracy while a value of 1/8 means less accuracy

l Number of decimals - the number of decimals for metric and decimal inches units, after the decimal 
point. 

l Default Data Entry Units - specifies the default units for data entry. The default data entry unit is 
used when the input value does not contain any unit notation.
For ex. 1250 mm is considered to be 1250 milimeteres because there is the "mm" suffix after the numeric 
value.
50" is considered to be 50 inches because there is the " sign after the numeric value.
However, if a value like 250 is entered, without the units suffix, the application will consider the default 
data entry units value. If "Default Data Entry Units" is set to centimeters, the 250 value will be entered 
as 250 cm. 

  

Units Settings

Under the "Units" tab you can set the "Display Units" as well as the "Data Entry Units".
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Print and Display Settings

Under the "Print and Display" tab you can set the display preferences for both screen and printer.

l Print full border for tables - if checked, full table border is printed. If unchecked, tables are printed 
using a clear style, rows being separated by a horizontal line.

l Display parts quantity status bar - show/hide the "Parts quantity status bar". This status bar is 
situated in the "Sources and parts" area, above the parts grid. It displays the total of parts entered so 
far. This can be useful for users of Smart1DCutting Free (30 parts), Smart1DCutting (100 parts), 
Smart1DCutting (1.000 parts) and Smart1DCutting (10.000 parts) 

l Currency - shows the currency format currently in use. To configure currency settings click the 
"Settings" button. The "Regional and Language Options" window will open. Next, you can simply select 
your country from the drop-down list or click the "Customize" button to manually adjust the settings. 
Make sure you click the "Apply" button to confirm the changes.
Please note that changing the currency will NOT perform any currency conversion.

l Columns Order - allows to change the order of columns in the grids. By default the columns order is: 
Description, Length, Qty, Material etc. To change the order of a column select it and click the "Up" or 
"Down" buttons to move the column up or down in the list. Click the "Save"  button to close the 
settings dialog window and to save the changes.
Certain columns can be disabled by unchecking their corresponding checkbox in the "Columns Order" 
grid. A disabled column will not appear in the program anymore until it is checked again. This can be 
helpful for users who do not need the extra fields like Part code, Notes, Left angle, Right angle or 
Works.
The main columns: Description, Length, Qty, Material are required by the program to work and can not 
be disabled.

l Display Options - allows to configure the display preferences like font name and size. 
To change the font on screen click the button "Font on screen...". To change the font at printer click 
the button "Font at printer...".
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Database Settings

Under the "Database" tab you can set the directory where the database files are stored and perform 
database backups or restores.
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Database location

By default, database files are stored in the "%commonappdata%\Rasterweq\Smart1DCutting\db" folder.

Smart1DCutting supports multiuser connections. By setting the database location to the same network 
drive on all workstations, you can have your data stored and accessed in one central location. 

IMPORTANT: The network drive must be shared with read / write permissions ! Otherwise 
Smart1DCutting will not be able to connect to the database.

Please refer to your operating system documentation for information about maping network drives.

To change the database location click the "Browse" button and select the new location for the 
database. Please note that Smart1DCutting must be restarted after changing the database location.

To reset the database location to the default folder "%commonappdata%
\Rasterweq\Smart1DCutting\db" click the "Default database location" button. Please note that 
Smart1DCutting must be restarted after changing the database location.

Cutting Layout location

By default, cutting layout files are stored in the "%userappdata%\Rasterweq\Smart2DCutting" folder. 
This location can be changed to "Database location" folder. This way, cutting layouts generated by one 
user are available to all users in the network. 

Auto-save changes for jobs 

By default, changes made to a jobs panels and parts lists are not automatically saved. When the user 
moves from one job to another and there are unsaved changes to the current job, a confirmation dialog is 
displayed asking the user if the changes should be saved or not. This behavior can be changed by enabling 
the "Auto-save" feature. The "Auto-save" function automatically saves changes made to the panels and 
parts lists. 

Database backup / restore

The database backup is a copy of all database files archived together in a single file. The database backup 
file can be used to recover a previous state of the database in case of data loss or to move the database 
to a different computer. It is a good practice to make database backups regularly and to keep them on a 
separate PC or better, on a removable media such as a CD/DVD-ROM disk. 

To create a backup of the database click the "Database backup..." button and after selecting the desired 
location on disk click "Save". The backup filename will be named based on the current date and time for 
easier identification when it comes to restore it.

To restore a previously created database click the "Database restore..." button and after selecting the 
desired backup filename click "Open". During database restore, all current database files are removed 
and replaced with files from the database backup.

IMPORTANT: If working in a multiuser environment, please make sure nobody else is using the 
database during the backup or restore process.
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Language Settings

Under the "Language" tab you can set the language of the application.
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l Change the language - to change the language select the desired language in the list. 

l Load language file - additional language files can be created and loaded into the program. To load 
such a language file click the "Load" button and browse for the desired file. Select it and click "Open" to 
load the language file into the list.

l Language files location - this option allows to set a central location for the language files. This can 
be useful when using the Smart1DCutting installation from a file server and the language files should be 
stored on the server. The available options are:
   - "Common Application Data": by default, language files are installed into the "Common Application Data" 
folder on local computer
   - Database location: when this option is checked the language files will be stored under the "Database" 
folder defined in the "Database" tab. If the database location is set to a folder on the file server the 
language files will be stored on the file server as well, under the database folder.

l Edit a language file - language files can be edited by clicking the "Language editor" button. In the 
language editor window, simply edit the text in the most right column. Changes are saved as each cell is 
edited. When you are done, you will need to reload the language file for the changes to be visible in the 
user interface. You can do this by restarting the program or by selecting another language first and then 
select your desired language back.

l Create a new language file - new language files can be created by clicking the "Language editor" 
button. In the language editor window, click the "Open" button and in the "File name" field type a name for 
your language file then click "Open". 
As you put in the translation for each string the changes will be automatically saved to the newly created 
language file. When you are done with your translation you will need to load the new language file into the 
program using the "Load" button.
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Using Smart1DCutting

Use this section to learn how to:

l Add sources and parts data 
l Run optimization 
l View and print the cutting layouts 
l Use the cutting report 
l View and print labels 
l Reuse offcuts and work with the stock management 
l Edit material types 
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Key terms definition

Source the source material from which the parts are to be 
cut

Parts the pieces that are to be cut from the source 
material

Offcuts the rest of source material remained after cutting 
out the parts. Offcuts or cut-offs can be reused so 
they are not really scrap. 
The length of the minimum reusable offcuts can be 
set in the Materials window under Edit -> Materials...

Scrap the very small offcuts or cut-offs which can't be 
reused
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About the user interface

Keyboard

INSERT Insert a new record after the selected row in the datagrid

ENTER Exit and save the current field and goes to the next field in 
datagrids

ESC Exit the edit mode of the currently edited field and cancel 
the changes (only if the changes were not already saved 
with the ENTER key)

CTRL + DEL Delete the selected row(s) in the datagrid

F1 Launch the help

F2 Switch the current field to edit mode 
(same with double-clicking the field)

F7 Start optimization

CTRL + C Copy the content of the selected cell(s) to the clipboard

CTRL + V Paste the content of the clipboard into the selected cell(s)

CTRL + S Save all changes in the current job

HOME Select the first cell in the current row

END Select the last cell in the current row

CTRL + HOME Select the first cell in the datagrid

CTRL + END Select the last cell in the datagrid
 

The buttons bar

You get a short help for each button if you let the mouse stay over the button for at least 1 second (so-
called tooltips). 
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Multiuser and network support

Smart1DCutting supports multiuser connections. By setting the database location to the same network 
drive on all workstations, you can have your data stored and accessed in one central location.
 
When working in a multiuser environment, the following restrictions apply:

l Only 1 user can edit a particular record in the same time. This restriction applies to Jobs, Stock, 
Materials, Works and Labels. When a user begins to edit a record that record is locked for writing. That 
means other users can only read the record, but can not modify it. If you try to edit a record which is 
already edited by another user you will receive the following error message, if during the 5 seconds 
timeout Smart1DCutting can not get write access to the record: 

 

If you receive this message, you should wait a few seconds and try again. If the message is repeated 
over and over again you should check if there is a Smart1DCutting instance running on another 
computer and locking that particular record.

l Adding and deleting records requires exclusive access to the database file.This restriction applies 
to Jobs, Stock, Materials, Works and Labels. If you try to add or remove a record from these database 
files but another user is editing a record in the same file and in the same time you will receive the 
following error message, if during the 5 seconds timeout Smart1DCutting can not get exclusive access 
to the database file: 

 

If you receive this message, you should wait a few seconds and try again. If the message is repeated 
over and over again you should check if there is a Smart1DCutting instance running on another 
computer and locking that particular database file.

l When editing sources or parts data for a job, changes are posted to the server only when you 
click the "Save"   buttons or when you select "Save" or "Save all..." from the menu.

l To manualy refresh the data for Jobs, Stock, Materials and Works you have to right click on their 
data grid and select "Refresh" or press the F5 key while in the data grid.
Jobs, Stock and Labels data is refreshed everytime you switch the tabs and enter their program 
sections. Materials and Works data is refreshed everytime you open their edit windows. 
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Sources and Parts

This is the area where information about available sources and needed parts is entered. To reach this 
section select "Sources and Parts" tab in the main window.

As you can see, the window splits in three areas: 
l Jobs area on the top 
l Sources area is on the left side 
l Parts area is on the right side.
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Jobs

Use this section to learn how to:

l Working with the jobs list (or jobs database) 
l Working with job files 
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Working with the jobs list (or jobs database)

In Smart1DCutting sources, parts and cutting layout files are grouped into jobs (or projects). All files 
belonging to a job are automatically loaded when that job is selected in the jobs list. 

The Jobs List allows you to easily manage your projects and provides an efficient way of accessing the 
jobs data when working in network mode. This way, users from different workstations can work on the 
same job in the same time but maintaining a single copy of the job and stock files on the server. 
For more information about setting up a central location for the database please click here.

 

To define a new job, right click on the jobs grid and select "Add new". Or you can alternatively use the 
"Insert" key or the  button from the buttons bar.

To change a job name or description, double click on the description field to switch it to edit mode or 
just type the new value and press [Enter] to validate.

Alternatively, you can edit job details by clicking the edit button  on the left of the job name.

 

To delete a job, select it first, then right click on the Jobs grid and select "Delete". Or you can 
alternatively use the "CTRL + Del" key combination or the  button from the buttons bar.

To save a job from the jobs list to a job file, first select the desired job in the grid then go to "File -> 
Save job as...". Job files can be loaded in the "Job files" section using the "File -> Open job..." menu 
function.
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Working with job files (single job mode)

The "Single job mode" section provides a classic way of working with jobs. You can create, load and save 
job files the same way you create documents in any other application. 

 

To define a new job, click the "New"  button on the buttons bar.

To load a job select "File -> Open job...", click the "Open"  button on the buttons bar or click the 
"Open job..." button on the right.

To change the job name or description, simply edit the text in the "Name" and "Description" fields and 
click the "Save"  button to save the changes.

To save the job as a another job file select "File -> Save job as..." from the menu or click the "Save job 
as..." button on the right. 

To add a job file to the jobs list so users from other workstations can access it click the "Add to jobs 
list" button. The job data, including sources, parts and cutting layout will be copied to the jobs 
database. 
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Sources

Use this section to learn how to:

l Manually add sources through the keyboard 
l Add sources from stoc 
l Load Smart1DCutting sources files (*.plc) 
l Manage sources 
l Import sources from CSV files 
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To insert a new source press the [Insert] key while in sources grid or click the  button from the buttons bar.

To change a field value, double click on the field to switch it to edit mode or just type the new value and press 
[Enter] to validate. 
The cursor will move to the next field.

Alternatively, you can edit source details by clicking the edit button  on the left of the source name. 

 

Please note that the material list will contain only those materials that are present in the Materials list. 
Smart1DCutting manages different material sources and parts based on this field. If you don't plan to use 
different material sources and parts you can leave this field empty all the time.

Important: Please make sure you enter the same material string for sources and parts with the same material 
type or you will not get the expected results. The best practice is to add the material type to the Materials list 
and then select it from the drop-down box for each source or part.  
Even the smallest difference between 2 material strings will cause the program to treat them as different 
materials. For ex.: "PVC Pipe" and "PVCPipe" are considered different material types by the optimization engine. 

  

Add sources manually

Use the Sources area to input sources information. The input procedure is very simple and is optimized for 
quick data input.

 

Once entered, data can be modified in the Sources list.
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Add sources from stock

Sources and/or offcuts previously saved in the stock database can be loaded into the Sources list before 
optimization.
To add sources or offcuts from stock, right click on the Sources grid and select "Add from stock..." as 
illustrated below.

 

Alternatively, you can click the "Add from stock"  button from the buttons bar or select Sources->Add 
from stock...

A new window showing the sources and offcuts that are currently in stock will open. Select one or more 
items from the list by checking their corresponding checkboxes and then click the "Save"  button. The 
selected sources will be copied to the Sources list. Default trim values will be aplied to the copied sources. 

 

Adjust the quantity field for added sources if necessary.
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Load Smart1DCutting sources files (*.plc)

In the Sources area look for the "Sources" button.

 

Left click on it and from the popup menu select "Load...". Browse for the file wich you want to load. Select 
it and click "Open" to load the sources file into the sources list.

The content of the file will be inserted into the grid after the selected row. 
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Manage sources files

In the sources area look for the "Sources" button.

 

Left click on it and from the popup menu select:

l New - to create an empty file and clear the Sources list  
l Load - to load/merge an existing sources file into Sources list  
l Add from stock - to add sources from stock to the Sources list  
l Import - to import sources data from a .CSV file  
l Export - to export the sources list to a .CSV file  
l Save - to save the Sources list  
l Save as - to save the current sources file with a different name  
l Add new - to insert a new record after the selected row in the grid  
l Delete - to delete the selected row(s) in the grid  
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Import sources from CSV files

To import sources data from a CSV file select "Sources -> Import..." or click the "Import"  button from 
the buttons bar.

 

A new window showing the content of the CSV file will open:

l Field delimiters - specifies the character used as a field delimiter: comma (,), semicolon (;), tab, 
space or other. Please click the "Refresh" button after changing a field delimiter.

l Start importing at row number - specifies the row number at which to start importing data. This is 
useful if the first row in the CSV file contains column headers. By setting the start row to 2 the column 
headers will be skipped. Smart1DCutting will recognize column headers and skip them if the column 
names are identical with those used by the program. Please click the "Refresh" button after changing 
the starting row number. 
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To change the name of a particular column in order to match its data click the column header to open 
the "Available fields" popup window:

 

Select a new name for the column and click "OK". To prevent a column from being imported set its name to 
"None".
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Parts

Use this section to learn how to:

l Manually add parts through the keyboard 
l Load Smart1DCutting parts files (*.pie) 
l Manage parts 
l Import parts from CSV files 
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To insert a new part press the [Insert] key while in parts grid or click the  button from the buttons bar.

To change a field value, double click on the field to switch it to edit mode or just type the new value and press 
[Enter] to validate. 
The cursor will move to the next field.

Alternatively, you can edit part details by clicking the edit button  on the left of the part name. 

 

Please note that the material list will contain only those materials that are present in the Materials list. 
Smart1DCutting manages different material sources and parts based on this field. If you don't plan to use 
different material sources and parts you can leave this field empty all the time.

Important: Please make sure you enter the same material string for sources and parts with the same material 
type or you will not get the expected results. The best practice is to add the material type to the Materials list 
and then select it from the drop-down box for each source or part.  
Even the smallest difference between 2 material strings will cause the program to treat them as different 
materials. For ex.: "PVC Pipe" and "PVCPipe" are considered different material types by the optimization engine. 

The part code field is printed on the labels in barcode format.

The left angle and right angle fields let you specify the final cutting angle of the part. The cutting angle values 
are for your information only, it doesn't affect the cutting layout in any way. During optimization, all parts are 
      
     

  

Add parts manually

Use the Parts area to input parts information. The input procedure is very simple and is optimized for quick 
data input.
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considered to have 90-degrees (90°) angle cuts at both sides. 
The cutting angle fields are printed on the Cutting Layout and on the Cutting Report.

  

 

 
 

 

Once entered, data can be modified in the Parts list.
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Load Smart1DCutting parts files (*.pie)

In the Parts area look for the "Parts" button.

 

Left click on it and from the popup menu select "Load...". Browse for the file wich you want to load. Select 
it and click "Open" to load the parts file into the Parts list.

The content of the file will be inserted into the grid after the selected row. 
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Manage parts files

In the parts area look for the "Parts" button.

 

Left click on it and from the popup menu select

l New - to create an empty file and clear the Parts list  
l Load - to load/merge an existing parts file into the Parts list  
l Import - to import parts data from a .CSV file  
l Export - to export the parts list to a .CSV file  
l Save - to save the Parts list to a file  
l Save as - to save the current parts file with a different name  
l Add new - to insert a new record after the selected row in the grid  
l Delete - to delete the selected row(s) in the grid 
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Import parts from CSV files

To import parts data from a CSV file select "Parts -> Import..." or click the "Import"  button from the 
buttons bar.

 

A new window showing the content of the CSV file will open:

l Field delimiters - specifies the character used as a field delimiter: comma (,), semicolon (;), tab, 
space or other. Please click the "Refresh" button after changing a field delimiter.

l Start importing at row number - specifies the row number at which to start importing data. This is 
useful if the first row in the CSV file contains column headers. By setting the start row to 2 the column 
headers will be skipped. Smart1DCutting will recognize column headers and skip them if the column 
names are identical with those used by the program. Please click the "Refresh" button after changing 
the starting row number. 
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To change the name of a particular column in order to match its data click the column header to open 
the "Available fields" popup window.:

 

Select a new name for the column and click "OK". To prevent a column from being imported set its name to 
"None".
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Optimization

The cutting layout, cost calculation report and the cutting report are generated by the optimization 
process. Smart1DCutting uses a powerful engine to generate the most optimized cutting layouts, 
providing for maximum material yield. 

There are 2 optimization levels :

l Level 1 - for fast and well optimized cutting layouts. For quick jobs the level 1 optimization will do the 
job. 

l Level 2 - it is slower than level 1, but it can provide better cutting layouts. Also recommended for 
large jobs. 

l Level 3 - ideal for jobs with up to 20-25 parts, this level can provide the best optimized cutting 
layouts. However, for larger jobs it is not recommended because as the parts list grows the 
optimization speed slows down considerably and the results are comparable with those provided by 
"Level 2". 

It is a good idea to try all 3 levels of optimization for your projects. Because there are so many different 
jobs with many different parts sizes, it is impossible to tell which optimization is best for a certain job. 
Only testing all levels you can be sure you get the best material yield.

To start the optimization process click the "Optimize"  button or press the F7 key.

To configure optimization related settings click the settings button  next to the "Optimize" button.

 

 

During optimization, a status panel is displayed showing the progress of the optimization.

The optimization process can be canceled by clicking the "Stop" button. In this case the cutting layout 
will not be complete. 

At the end of the optimization the cutting layout is automatically displayed.
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Cutting Layouts

This is the area where the cutting layout is displayed as a result of the optimization process. To reach this 
section select "Cutting Layout" tab in the main window.

The "Cutting Layout" window is made up of 3 sections:

l The Layouts preview pane - is situated on the left and it displays a list of the cutting layouts and 
the required sources. Above the layouts list there is a preview pane which shows a preview of the 
selected layout in the list. You can navigate through the layouts using the navigation buttons. 

l The Layout Info Area - is situated on the right and it displays information about the parts and 
offcuts contained in the selected cutting layout. 
The description field of sources, parts and offcuts can be edited. The changes are visible on the 
printed cutting layout and on the labels (only when "Label View 1" and "Cutting layout order" is 
selected). The text entered on the cutting layout tab is reset when a new job is loaded or when the 
optimization is executed. To keep the changes, the cutting layout needs to be saved.
This feature facilitates the communication between the person who is generating the cutting layout 
and the workers who are cutting the pieces. 

l The Status Bar - displays some useful information like current layout, offcut area, saw width and 
multiplication (required qty of sources for each layout). 
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Using the Cutting Layout

Working with the Cutting Layout actually involves 3 actions: interpreting, loading/saving and printing the 
cutting layouts.

l Interpreting the Cutting Layout 
 
The cutting layout is made up of one or more layouts or pages. Each page contains the cutting layout 
for an individual source from the Sources list. If more sources have the same cutting layout, still only 
one layout is displayed, but the multiplication factor is incremented for each source. This means that 
a cutting layout having a multiplication factor of 3 actually represents 3 sources with the same length 
and material but also with the same number and disposition of parts on them.

Parts and offcuts from every cutting layout are identified by an ID number. Parts ID number 
(identification number) is an ordinary number (e.g. "3") and is in fact the part No. in the Parts grid. 
Offcuts ID number is made up of an 'R' and an ordinary number (e.g. "R3"). 

l Loading and saving the Cutting Layout 
 
The cutting layout can be saved to a file and reused later. By loading a previously saved cutting 
layout there is no need to run optimization. To load/save the cutting layout use the "Load"  and 

"Save"  buttons from the buttons bar. 

l Exporting the Cutting Layout to TXT file

The cutting layout can be saved to a plain text file in order to further process it using other software 
applications. To save the cutting layout as a .txt file click the "Save"  button and select "Text file" 
from the "Save as type" drop-down box. Cutting layouts saved as TXT files can not be loaded back 
into Smart2DCutting.

The text file has the following format: 

          A|1790|PVC Pipe|PVC Pipe source
          B|1500|0|Sample part 3
          C|1790|0|Offcut

The sources line always start with the letter 'A' and the other columns are: Length, Material, 
Description, Note, Type (0=source, 1=offcut).
The parts line always start with the letter 'B' and the other columns are: Length, Left, Description, 
Note.
The offcuts line always start with the letter 'C' and the other columns are: Length, Left, Description. 

The values in the length column are in mm and they represent the length of the part.
The values in the left column are in mm and they represent the horizontal (X) offset of the part from 
the left side of the source. 

l Exporting the Cutting Layout to XML file

The cutting layout can be saved to XML file format in order to further process it using other software 
applications. To save the cutting layout as .xml file click the "Save"  button and select "XML files" 
from the "Save as type" drop-down box. Cutting layouts saved as XML files can not be loaded back 
into Smart2DCutting.

l Printing the Cutting Layout
 
The cutting layout is displayed on the screen and is looking pretty good. But it's more useful if you 
can have it on paper. To print the Cutting Layout click the "Print"  button from the buttons bar. 
You can select to print all pages or just some of them. 
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Cost Calculation Report

The Cost Calculation Report displays information about the costs for needed sources as well as 
operational costs for parts and material cutting. To reach this section select "Cost calculation" tab in the 
main window.

To print the Cost Calculation Report use the "Print"  button from the buttons bar. 

The "Cost Calculation Report" is made up of 5 sections: Total costs, Material cost, Works cost and 
Cutting cost.

 

l Total cost - displays the total costs for each section and the grand total.  

  Material cost - the total cost of materials, that is the total of the "Total with waste" column in 
the "Material cost" grid

  Works cost - the total cost of works, that is the total of the "Cost" column in the "Works cost" 
grid

  Cutting cost - the total cost of material cutting, that is the total of the "Cost" column in the 
"Cutting cost" grid

  Total - the grand total, that is the sum of the previous fields: Material cost + Edge 
banding cost + Works cost + Cutting cost
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l Material cost - displays cost information about used materials and resulted offcuts.  

  No. - row number
  Material - material of the source
  Length - length of the source
  Qty - the qty of used sources
  Price - the price of the material, per area unit, as defined in the Materials window
  Usage - the surface and cost of the used sources area

  Waste - the surface and cost of the waste area. Waste area is the sum of scrap area and 
saw waste area

 
Total with 
waste

- the cost of the material including waste: (Usage surface x Price) + (Waste 
surface x Price)
  Offcuts cost is not added to this total because offcuts can be reused

  Offcuts - the cost or value of reusable offcuts

 

 

l Works cost - displays cost information about the operational costs for parts. 

  No. - row number
  Name - the name of the works
  Qty - the qty of parts for which the works is set
  Price - the price of the works, per part, as defined in the Works window
  Cost - the cost of the works: (Qty x Price)
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l Cutting cost - displays cost information about the cutting operation. 

  No. - row number
  Material - material of the source
  Count - the number of cuts, calculated for all parts for which cutting is required
  Price - the price of the cutting operation, per cut, as defined in the Materials window
  Cost - the cost of the cutting operation: (Count x Price)
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Cutting Report

The Cutting Report displays information about the sources, parts and offcuts contained in the whole 
cutting layout. To reach this section select "Cutting Report" tab in the main window.

To print the Cutting Report use the "Print"  button from the buttons bar. 

The "Cutting Report" is made up of 3 sections: Sources, Parts and Offcuts. 

 

l Sources - displays information about the sources in the cutting layout as a result of the optimization 
process. 

  No.   - identifying number of the source
  Description   - description of the source
  Length   - length of the source

  Available   - the number of available sources (equal to the qty field in the Sources 
list)

  Used   - the number of used sources in the cutting layout
  Remaining   - the number of sources that were not used in the cutting layout
  Material   - material of the source
  Notes   - notes about the source

  Type   - the source type: it can be "Source" if it is a new source or "Offcut" if 
the source is an offcut resulted from previous optimizations.
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l Parts - displays information about the parts in the cutting layout as a result of the optimization 
process. 

  No.   - identifying number of the part
  Description   - description of the part
  Length   - length of the part
  Required   - the number of needed parts
  Done   - the number of parts that fit on the layout
  Remaining   - the number of parts that did not fit on the layout
  Material   - material of the part
  Part code   - the code that is going to be printed as barcode on the labels
  Notes   - notes about the part

  Left angle / Right 
angle

  - the cutting angle for each side of the part 

  Works   - the works for the part

 

l Offcuts - displays information about the offcuts in the cutting layout as a result of the optimization 
process.

  No.   - identifying number of the offcut
  Description   - description of the offcut
  Length   - length of the offcut
  Qty.   - number of offcuts in the cutting layout
  Material   - material of the offcut 
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Labels

Smart1DCutting allows to print labels that include parts, sources and reusable offcuts information. To print 
labels select "Labels" tab in the main window and select the label style you want to use from the available 
label styles list.

To print the labels use the "Print"  button from the buttons bar. 

To export the labels to a CSV file use the "File->Export->Labels..." menu option while in the "Labels" tab. 

There are 2 label views available: Label View and Report View

Label View

The "Label View 1" option layouts the labels to fit on a label sheet. There is one label for each source, part 
or offcut.
The labels in "Label View 1" can be sorted in the following ways:
    - "Cutting layout order": the labels are printed in the order they appear in the cutting layout 
    - "Cutting report order": the labels are printed in the order they appear in the cutting report 

The "Label View 2" option layouts the labels to fit on a label sheet. Unlike for the "Label View 1" option, 
only the lenth and the total quantity of sources, parts and offcuts are printed.
 

 
Choosing which labels to print
 
You can choose wich labels to print by checking the corresponding checkbox for parts, sources or reusable 
offcuts.
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offcuts.

 

Additionally, while in the "Print preview" window (after clicking the "Print" button), you can configure the 
"Start label" option to set the starting position for label printing. This is useful when you have a partially 
used label sheet left from a previous job. 

Configuring labels

Labels properties can be set to fit any type of label sheets.
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Page orientation and borders

Depending on what type of label sheets you are using you can change the page orientation or the paper 
size.

To change the paper size, click the "Printer settings" icon  

You should use borders if you are printing labels on plain paper. When printing on label sheets, you do not 
need borders. There are five border types available: Solid, Dash, DashDot, DashDotDot and Dot.

Setting font and text alignment

You can change the font name and size and also the text alignment of the labels to suit your needs.

Label Size

Use "Width" and "Height" to set dimensions of individual labels. 

Page Margins, Spacing and Count

Use Page Margins to position labels on the sheet. Some label manufacturers have the information about 
labels position printed on sheets. If not, you should measure your label sheet to determine the exact 
position of labels. Then use the settings to align the text so it is printed on labels precisely.

To set the number of rows and column use "Row count" and "Column count" properties.

To set the distance between rows and columns use "Horizontal spacing" and "Vertical spacing" properties. 

Configuring label text

Use the Alignment property to set the text alignment on the labels.

To set the position of each band within the label use "Name band pos", "Dim band pos", "Material band 
pos", "Info band pos", "Note band info" and "Barcode band pos" properties.
To let the program position each band automatically enter 0 or "auto". To set your desired position for 
each band use the "up/down" button to increase or decrease the band position on the label. You can also 
type a number instead of using the "up/down" button.
To disable a particular text line uncheck its checkbox.
To change the color of a particular text line click the color button  next to its checkbox.

To change the text style attributes of a particular text line click the text style buttons  on its 
grid line. 

Barcodes 

To change the font used for printing the barcodes use the "Barcode font name/size" properties. 
Smart1DCutting comes with a barcode font called "Free 3 of 9 Extended". If you have other barcode fonts 
installed on your system you can select them from the fonts list. The barcode font properties are different 
than the labels font properties.

The "Barcode start/stop char" specify the start/stop character used when printing the barcode. A valid "3 
of 9 barcode" have to begin and end with a special character. Scanners look for this character to know 
where to start and stop reading the barcode. This special character is represented in this font with the '*' 
character. The barcode readers will not include the * in the text they return.
Please note that for other barcode fonts the start/stop character might be different or it might not be 
needed at all. You should consult your barcode reader documentation to find out the start/stop character 
they expect. 
 
All changes you make in the active Label Style are automatically saved. Use the  and  buttons to 
add or remove label styles.
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Report View

The "Report View" is especially useful when there is no need to print labels but to keep track of the 
material.
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Stock Management

This is the area where information about available sources is displayed. To reach this section select "Stock 
Management" tab in the main window.
The Stock Management role is to help you to keep track of used sources and reusable offcuts.

The "Stock Management" window is made up of 2 sections:

The booking area - is situated on the left and it displays the required sources and the resulting 
offcuts for the current cutting layout. The booking process can be started by clicking on "Execute 
booking " button. 

The Stock area - is situated on the right and it displays the sources and reusable offcuts in stock.  

Please click the links below to learn how to:

l Manually add stock items through the keyboard 
l Manage stock data 
l Import stock data from CSV files 
l Execute booking 
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To insert a new stock item press the [Insert] key while in stock grid or click the  button from the buttons bar.

To change a field value, double click on the field to switch it to edit mode or just type the new value and press 
[Enter] to validate. 
The cursor will move to the next field.

Alternatively, you can edit stock details by clicking the edit button  on the left of the item name. 

 

The Material price defined here for a particular source length & material overwrites the material price set in the 
Materials window, for that particular source. 
For ex.: if you defined a price of $10/m for the material type "Steel Pipe" in the Materials window, this price will 
be used for all sources having "Steel Pipe" as material, regardless of their length. But, if you define a new price 
in the "Stock item details" window for source length 2500 mm and material type "Steel Pipe", this new price will 
be used for all 2500 mm "Steel Pipe" sources instead of the price set in the Materials window for the "Steel Pipe" 
material type.

Please note that the material list will contain only those materials that are present in the Materials list. 
Smart1DCutting manages different material sources and parts based on this field. If you don't plan to use 
different material sources and parts you can leave this field empty all the time.

Important: The best practice is to add the material type to the Materials list and then select it from the drop-
down box for each stock item. 
Even the smallest difference between 2 material strings will cause the program to treat them as different 
materials. For ex.: "PVC Pipe" and "PVCPipe" are considered different material types by the optimization engine. 

  

Add stock items manually

Use the Stock area to input stock items. The input procedure is very simple and is optimized for quick data 
input.

 

Once entered, data can be modified in the Stock list.
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Manage stock data

In the Stock area you can use the filter function to select what data you want to be displayed. For ex.: if 
you select "Qty" ">=" and "100" in the filter boxes as illustrated below, only stock items with their qty 
higher or equal to 100 will be displayed. To reset the filter and display all items select "No filter" for the 
first filter drop-down box. 

 

The meaning of each button on the buttons bar is as follow:

l Sources button - when checked  sources are displayed in the stock grid; when 

unchecked  sources are not displayed in the stock grid 

l Offcuts button - when checked  offcuts are displayed in the stock grid; when 

unchecked  offcuts are not displayed in the stock grid 

l  New - to create an empty stock and clear the existing Stock list.  

l  Import - to import stock data from a .CSV file  

l  Export - to export the stock list to a .CSV file  

l  Add new - to insert a new record after the selected row in the grid  

l  Delete - to delete the selected row(s) in the grid  

WARNING! - Please make sure you have a backup copy (i.e. a CSV file export) of the stock data 
before using the "New" , "Import"  and "Delete"  functions. Once performed, these 
operations can not be undone!
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Import stock data from CSV files

To import stock data from a CSV file click the "Import"  button from the buttons bar.

 

A new window showing the content of the CSV file will open:

l Field delimiters - specifies the character used as a field delimiter: comma (,), semicolon (;), tab, 
space or other. Please click the "Refresh" button after changing a field delimiter.

l Start importing at row number - specifies the row number at which to start importing data. This is 
useful if the first row in the CSV file contains column headers. By setting the start row to 2 the column 
headers will be skipped. Smart1DCutting will recognize column headers and skip them if the column 
names are identical with those used by the program. Please click the "Refresh" button after changing 
the starting row number. 
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To change the name of a particular column in order to match its data click the column header to open 
the "Available fields" popup window:

 

Select a new name for the column and click "OK". To prevent a column from being imported set its name to 
"None".
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Booking

 The are 2 booking types available: Booking for sources and Booking for offcuts.

1. Refreshing the information about sources and reusable offcuts. This is done by clicking the "Refresh" 
button. 

2. Launch the booking procedure by clicking the "Execute booking" button. 

 
The booking process for sources will: 

1. Substract the quantity of required sources from the quantity of existing sources in stock. Sources 
not present in stock will appear with negative values in the quantity field. 

2. Update the value of the "Last updated" label on the bottom of the stock grid. 

Prior to booking, sources can be added or removed from the list.

To launch the booking procedure for sources click the "Execute booking >>" button from the "Required 
sources" section. 

The booking process for sources can be automated by checking the option "Execute booking for sources 
after each optimization".

To reset the "Required sources" list to its initial state click the "Refresh" button from the "Required 
sources" section. 

Please note that once executed, the booking process can not be undone! 
 
 
 
The booking process for offcuts will: 

1. Add the offcuts in the list of offcuts to the stock. 
2. Update the value of the "Last updated" label on the bottom of the stock grid. 

Prior to booking, offcuts can be added or removed from the list.
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To launch the booking procedure for offcuts click the "Execute booking >>" button from the "Offcuts" 
section. 

The booking process for offcuts can be automated by checking the option "Execute booking for offcuts 
after each optimization".

To reset the "Offcuts" list to its initial state click the "Refresh" button from the "Offcuts" section. 
 
To save the offcuts list as a Smart1DCutting source file (*.plc) click the "Save as..."  button.

To export the offcuts list to a CSV file click the "Export"  button. 

Please note that once executed, the booking process can not be undone!
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Edit Materials

To edit materials select Edit -> Materials... from the application main menu.  

 

A new window showing the existing materials and their options will open:

The "Materials" window is made up of 3 sections: Materials, Minimum offcuts values and Material price 
calculator.
 

l Materials - allows you to configure materials options 

Smart1DCutting manages different material sources and parts based on the material field. 

  Name   - the name of the material. This name appears in the "Material" field of 
sources, parts and offcuts. 

 
Saw width   - the saw width is defined for each material. The saw width is an 

important value. It should reflect the width of the cut to get accurate 
cutting layouts. 

 

Material price   - the price of the material per length unit. It can be defined per meter, 
inch, feet or per source. It is used for cost calculation. 
When the price is defined per source, the program will add to the total 
cost the price of each source used, regardless of source usage. 
Note: The material price defined here is at material level, regardless of 
the source lengths. To set the material price at the source level, for each 
length, please see the Stock Management section. 

  Cutting price   - the price of the cutting operation, per cut or per source. It is used for 
cost calculation. 

  Description   - the description of the material. This field doesn't appear anywhere else 
in the program.
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l Minimum offcuts values - allows to define the minimum length for reusable offcuts, for the selected 

material type. Reusable offcuts are displayed on the cutting layouts and qualifies for the booking 
process.

The key to maximum material yield is reusing offcuts.
Surplus material that is left after cutting can often be used in another project.
Smart1DCutting can determine which offcuts to keep based on minimum length of reusable offcuts. 
Reusable offcuts are labeled on the cutting layout and printed in reports. 
For details on how to keep reusable offcuts see the booking process section. 

       

 
Enable tracking of 
minimum offcuts 
values

  - when checked Smart1DCutting will report offcuts if their length is equal 
or higher than the minimum offcut length.

  Minimum offcuts 
values

  - the minimum Length for an offcut to be recorded.

 

 
l Material price calculator - allows you to calculate material price per length unit, giving the source 

price. This is useful when you only know the price of the source but not the price per length unit.

Enter the price per source, the length of the source and the material price per length unit will be 
calculated automatically. You can use the "Price unit" field to set the length unit for which the price is 
to be calculated: meter, inch or feet.
To assign the material price to the selected material, click the "Set new price" button.

  Material   - the material for which the price is to be calculated. This field is read-
only and it change based on the selected material.

  Price per source   - the price of a whole source.
  Source length   - the length of the source.
  =============    

 

Price unit   - the length unit for which the price is to be calculated. It can be meter, 
inch or feet. 
Please note that for low prices of the source, the material price per inch 
can be very small ( < 0.01 ) and it will not be considered. In this 
situations please use feet or meter for the "Price unit" field.
When the "Price unit" is set to "source" the length value is ignored. 

  Material price   - the price of the material per length unit. The price is calculated for the 
length unit specified in the field "Price unit".

 

Use the buttons from the top buttons bar to Print , Add  or Remove  materials.
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Edit Works

To edit works select Edit -> Works... from the application main menu. 

 

A new window showing the existing works and their options will open:

Works represent the operational costs involved for parts production (additional to material costs). You can 
define different works types, each with its own price.

No.   - the row number. This value is used in the works selection drop-down list, in 
parts grid.

Name   - the name of the works. The name is printed only on "Cost calculation" report. 
In parts grid, the works no. is displayed instead.

Price   - the price of the works, per part. The price should represent the operational 
costs for 1 part.

Description   - the description of the works. This field doesn't appear anywhere else in the 
program.

 

Use the buttons from the top buttons bar to Print , Add  or Remove  works.

Page 65 of 76



Order and Register

Smart1DCutting can be ordered online, at Rasterweq Software Website - www.rasterweq.com. 

Your order will be processed online through a secure server. You can pay with Visa, Mastercard/Eurocard, 
American Express, Diners Club, PayPal, Bank Transfer/Wire, check or cash.

There are 4 levels of registration. The parts limit per job can be increased to 100, 1.000, 10.000 or to 
Unlimited. 

Upgrades are possible for all license types. Please visit the upgrades page at our Web site: 
www.rasterweq.com/upgrade1d.php for more information.
If you upgraded your license and need help to get it working please read the license upgrades help page.

To view current pricing and to start the ordering process, please visit the online order page at our Web 
site: www.rasterweq.com/order.php.

After you submit the online order and your order has been processed, your Serial Number will be sent to 
you immediately. This usually takes a few hours for credit card payments, and should not take longer than 
two business days for credit card payments or two weeks for other payments. In case you do not receive 
your Serial Number within this period of time, please contact us immediately. 

The registered version of Smart1DCutting requires activation for each workstation on which it is used. 
Activation is totally secure and anonymous. No personal info is required. There are 2 activation methods:
l Online activation - the activation info is sent to our server by the program automatically. Requires 

internet connection. 
l Offline activation - the activation info is sent to our server by you manually, via a webpage, from any 

computer with internet connection. Recommended if the computer where you installed Smart1DCutting 
doesn't have internet connection or if "Online activation" doesn't work for you.

You can read our activation policy here.

Please feel free to contact us anytime with your Serial Number and Computer ID in case you need 
assistance with the activation process.
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About parts limit and registration levels 

There are 4 levels of registration. The parts limit per job can be increased to 100, 1.000, 10.000 or to 
Unlimited, depending on which license you purchase.

The parts limit allowed by each registration level means the total quantity of parts that can be optimized 
at once per job. For example, the 1.000 parts license will allow for a maximum of 1.000 parts to be 
optimized in every given job. You can have several jobs with 1.000 parts or less, but in every single job 
the parts limit would be 1.000. That is, you can have 100 or more jobs, each one consisting of 1.000 
parts, but none can have 1.001 or more parts. You can enter as many parts you wish in a job but the 
optimization engine will complain if the parts quantity is higher than the maximum parts quantity allowed by 
the license in use.
 
The parts represents the pieces that are to be cut from the source sources or boards. For example, if you 
have the following parts list

Material Length Quantity
PVC Pipe 450 mm  10
PVC Pipe 534 mm  20
PVC Pipe 576 mm  16
PVC Pipe 518 mm  3

Total quantity:  49
 
The total quantity of parts would be: 10 + 20 + 16 + 3 = 49. The total quantity is the sum of all parts 
quantity in the current job.
 
 
In the "Sources and Parts" section, above the parts grid, there is a "Parts qty status bar" that displays the 
total quantity of the parts for the currently selected job.
 

 
If the parts quantity goes above the parts limit allowed by the license, the status bar becomes red.
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Online activation

If Smart1DCutting was not activated, the activation wizard will start when you launch the program:
 

 
Select your language and click the "Next" button to start the activation process.
 
 

 
Select "Internet Activation" and click "Next".
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Enter the Serial Number received by email after product purchasing. In case you ordered Smart1DCutting on 
CD, the Serial Number should be printed on the CD cover. The serial number should start with the "SMR1D" 
string.
Click "Next" to finish the activation process and.receive registration info from the server.
 
 

 
If the Serial Number you entered is correct, you should see the "Activation is complete" screen displaying 
your Registration Name and ordered License type. Click "Finish" to start using Smart1DCutting.

In case you receive an error please click the "Back" button and check if the serial number entered is 
correct and try again. The serial number should start with the "SMR1D" string.
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Offline activation

If Smart1DCutting was not activated, the activation wizard will start when you launch the program:
 

 
Select your language and click the "Next" button to start the activation process.
 
 

 
Select "Offline Activation" and click "Next".
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Enter the Serial Number received by email after product purchasing. In case you ordered Smart1DCutting on 
CD, the Serial Number should be printed on the CD cover. The serial number should start with the "SMR1D" 
string.
Click the "Next" button to continue.
 
 

 
If your computer is connected to Internet click the "Activation Link" to open the activation web page. If 

your computer can not access the Internet click the "Copy" button  to copy the activation link to 
clipboard. You can "Paste" the activation link to a text file and execute it on any computer with internet 
access.
Alternatively, you can open the activation page http://www.rasterweq.com/activation.php in a browser 
and manually enter your Computer ID and Serial Number. The activation web page should look like this:
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Click the "Activate" button to submit the activation data. If the activation data submited is correct you 
should see a link to a registration file which you can download and save on your computer as well as your 
Registration Name and Key displayed on the next page. 

l Register Smart1DCutting using the registration file 
l Register Smart1DCutting using the Registration Name and Key 

In case you receive an error please click the browser "Back" button and check if the Serial Number and 
Computer ID are correct. The serial number should start with the "SMR1D" string. 
 
 
To register Smart1DCutting using the registration file
 
Click the "Load" button in the program activation window, which should be still open ...
 

 
and browse to the "Smart1DCutting Registration File" you just downloaded from the activation web 
page:
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Select the registration file and click the "Open" button. You should see your Registration Name and Key 
loaded into the activation window. Then click "Next".
 

 
If the Registration Name and Key you entered are correct, you should see the "Activation is complete" 
screen displaying your Registration Name and ordered License type. Click "Finish" to start using 
Smart1DCutting.

In case you receive an error please click the "Back" button and check if the Registration Name and Key 
entered are correct and try again.
 
 
To register Smart1DCutting using the Registration Name and Key
 
Copy the Registration Name and Key from your browser window to the clipboard and paste them into the 
program activation window, which should be still open ...
 

 
 
 

 
 
 
  

 
 
 
 

Page 73 of 76



 

   
 

 
 
 
 

 
 
 
 

 
   
 
 
 
 
 

 
 

  
 
 
   
 
 
 

 
 
 
 

     
     

 
 
 
 
   
 
 
 

 
     
 
 

 
 
 
 

 
 
 
  

 
 
 
 
   
 
 
 
 

 
then click "Next".
 

 
If the Registration Name and Key you entered are correct, you should see the "Activation is complete" 
screen displaying your Registration Name and ordered License type. Click "Finish" to start using 
Smart1DCutting.

In case you receive an error please click the "Back" button and check if the Registration Name and Key 
entered are correct and try again.
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License upgrades

Upgrades are possible for all license types. Please visit the upgrades page at our Web site: 
www.rasterweq.com/upgrade1d.php for more information.

After you purchased a license upgrade and received the confirmation email, you will need to reactivate 
your copy of Smart1DCutting. The reactivation can be done from the "Registration" dialog. To open the 
"Registration" dialog select Help -> Registration from the menu: 
 

 
To reactivate Smart1DCutting click the "Activate again (upgrade)" link:
 

 
A confirmation message box will appear asking for your confirmation. Click "Yes" to remove the current 
license key and to restart Smart1DCutting. The activation wizard will start and will assist you with the 
activation process. There are 2 activation methods: 

l Online activation - the activation info is sent to our server by the program automatically. Requires 
internet connection. 

l Offline activation - the activation info is sent to our server by you manually, via a webpage, from any 
computer with internet connection. Recommended if the computer where you installed Smart1DCutting 
doesn't have internet connection or if "Online activation" doesn't work for you.
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Technical Support

As a registered user, you are entitled to free technical support by e-mail. 

Send your questions, suggestions and bug reports to: support@rasterweq.com.

Please include your reference number with the inquiry. This would make it easier for our staff to identify 
you and respond to your inquiry.

Feel free to contact us anytime. Our staff will make sure your inquiries are processed and answered as 
soon as possible - we do not use automatic responders. 

Our online contact form is located at www.rasterweq.com/contact.php 
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